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Scientific image

• Is different than a regular digital photograph of a 
beautiful scene you shot. 

• Digital images are samples of information 
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What is Digital Image Analysis?

• Using the numbers in digital pictures to get useful information

• REMEMBER:

• Start with an image -- end with an answer
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How can you download image J 

•
https://www.embl.de/services/core_facilities/almf/serv
ices/downloads/imageJ/imageJ_setup/

You just double click with EMBL ImageJ setup v1_0f, 
and then file downloading will be start.

• You have to download Java using this link 

• https://java.com/en/

• If you have any message concerning Javaw.exe just 
open the setuped version in program files and click that 
file then complete setup steps and open image J 
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When opening the program you will get this window just 
choose allow access 
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Some information about the program

• 1- Runs everywhere: it  is written in Java, It to run 
on Linux, Mac OS X and Windows, in both 32-bit 
and 64-bit modes.

• 2- Open source:  ImageJ and its Java source code 
are freely available and in the public domain. No 
license is required.

• 3- ImageJ has a large and knowledgeable 
worldwide user community.

• 4- Data types: 8-bit grayscale or indexed color, 16-
bit unsigned integer, 32-bit floating-point and RGB 
color 
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Some information about the
program
• 5- File Formats: Open and save all supported data types as TIFF

• 6- All analysis and processing functions work at any magnification 
factor.

• 7-Selections:

• Create rectangular, elliptical or irregular area selections. Create 
line and point selections. Edit selections and automatically create 
them using the wand tool. Draw, fill, clear, filter or measure 
selections. Save selections and transfer them to other images.

• 8- Image Enhancement:

• Supports smoothing, sharpening, edge detection, median filtering 
and thresholding on both 8-bit grayscale and RGB color images. 
Interactively adjust brightness and contrast of 8, 16 and 32-bit 
images.
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To know about the program after setup  
help then about image J 
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Different bars of the program 
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Common tools in image J 
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Adjusting image contrast and brightness 
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Important notes 

• Adjusting contrast and brightness is just for pictures
you take for demonstration and not in captured
photo for analysis because when you capture it you
adjust settings in all groups.

• It is not a tool to change anything about analyzed
image.
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Analysis done by image J 

•Measure area, mean, standard
deviation, min and max of selection or
entire image.

•Measure lengths and angles. Use real
world measurement units such as
millimeters.
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Topics that will be covered today 

• 1- Analysis of gel and western blot images 

• 2- Analysis of fluorescence and 
colocalization signal of immunofluorescence 
images

• 3-Analysis of nanoparticle size distribution 

• 4- Analysis of stained liver tissue 

• 5-Counting the cells 
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Analysis of DNA gel using 
image J



Steps you can follow as screen 
shot 
• 1- open image J software from its setuped icon 
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This is the image 
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Open the image of gel you want to analyze  By 
clicking file menu then open 
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As image J can not read the white bands so invert colors in 
image by edit ….invert 
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Photo after color inversion……bands will appear in 
black  
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Select the area of bands using rectangular selection 
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Analyze ….gels …..select the first lane
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Analyze-gel-plot lanes 
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Use straight line tool and shift to detect 
bands
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Another option to select area of each 
band separately 
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Use wand tool to detect areas of  bands  
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Click analyze gel ----label peaks 
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You can save your results by clicking file ….save 
as in results window 
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Then open in excel and analyze the results 
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In this case which is semiquantitative 
analysis of DNA in gel image  

• You can calculate the fold change by dividing over 
the area or percent of each group or band on that 
of control 

• You can add the values on each band in the image 
that will be added in paper. Something like in this  
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Analysis of western blot 
image 



Western blot overview 
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Harry Towbin, in Encyclopedia of Immunology (Second Edition), 1998

https://www.sciencedirect.com/referencework/9780122267659


Image for western blot 
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Open the image in image J 
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As there is too much free space crop the 
image 

Thoria Donia 



Rectangular selection then image crop 
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Image became as in view 
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As in this image select one lane and the last one 
which is internal control as following 
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It will be selected with no. 1 in the middle 
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Move the selection to the last lane and analyze 
gel select next lane and no.2 will be added on 
this lane 
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Analyze …gel …plot lanes 
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Make selection like this using shift and line 
tool
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Use wand tool to analyze area of each 
band 
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You just click wand tool and in the middle
of area click you will get the area size in
results file
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Click analyze gels then label peaks you will 
get the percent of area 
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Then file ---save as and save results for 
further analysis 
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To get the fold change of each band first divide 
over that of each internal control then the 
resulted value on control value (non treated)
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Analysis of fluorescence signal you get 
from confocal microscopy 
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Immunofluorescence 
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Thoria Donia https://rockland-inc.com/ihc-
products.aspx

https://rockland-inc.com/ihc-products.aspx


Analyzing fluorescence in this image 
(lysotracker staining)
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Open the image in image J 
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Split  colors in this image as following  
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You will get three images with different 
color layers 
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Note:

• The green layer is not included as you have only 
red fluorescence and blue for nucleus and we will 
use blue layer later in counting cells. 

• So  Just close the green layer window and other 
images will be analyzed separately one to get red 
fluorescence and the other for cell count. 
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For counting cells 
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Edit …..invert 
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Remove the diameter of cell (as no. ) by 
eraser 
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Image -----adjust-----threshold 
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Move the down scroll of threshold window 
till adjusting nuclei view 
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Click apply and analyze---particles …60-
infinity   
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Important 

• You should fix the settings for analysis of

images in different groups to get acceptable

meaning.
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Analysis of red fluorescence 
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Edit ------invert 
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You will get white background and black 
fluorescent signal 
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Remove diameter by eraser
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Image----adjust-----threshold
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Click apply or move the down scroll to
clarify the fluorescence then analyze
…..analyze particles
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Keep all settings in default version with just 
changing size to be 0-infinity 
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Important note: 
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Image J guide book

0 (infinitely elongated polygon) to 1 (perfect circle).



Results will appear in summary 
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To calculate the signal per cell 

• Just divide the red signal results on number of cells 
and the signal will be per cell as this example 
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Important note: 

• Thresholding tool setting in a positive control
specimen should then be duplicated in every image
to be compared
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Colocalization Analysis
Colocalization .....observation of the spatial
overlap between two (or more) different
fluorescent labels, each having a separate
emission wavelength, to see if the different
"targets" are located in the same area of the cell
or very near to one another. ”



Images for analysis of colocalization 
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Open the image in image J 
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Split image colors 
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Delete the blue color image for DAPI
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Click plugins ----choose colocalization
analysis then colocalization highlighter

Thoria Donia 



Record the settings you used to apply the 
same for all studied images 
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You will get two images  

• One for colocalized points in 8 bit and the other in 
RGB

• You can save them and the image for analysis will 
be 8 bit  
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Colocalized point (8 bit)
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Edit …..invert 
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Erase the diameter 
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Analyze -----analyze particles ….keep 
default settings….ok 
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We just focus on count column which 
expresses colocalization  
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Count the number of cells by splitting the 
image colors and keeping blue one. 
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Edit …invert 
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Then remove the diameter by
eraser
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Adjust …..threshold 
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Adjust the down scroll to right till you get 
the clear nuclei 
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Apply to get such view 
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Analyze ….analyze particles 
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Keep all settings in default form with
changing size to be 60- infinity
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Save analysis or continue analyzing other
images and all results will appear in
summary
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Final result should be like that colocalized
pixel/cell by dividing the colocalized area
(total area column)over the no. of cells
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Nanoparticle size distribution analysis 
by image J 
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Published paper 
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Picture containing SEM analysis 
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I separate the picture in paint and saved as 
TIFF file 
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In image J file -----open ----choose SEM 
image from specific partition on your 
computer
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Click straight line tool with shift and 
select the scale at the end of picture 

• In this SEM picture, it is 200 nm 
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Analyze then set scale 
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Add 200 nm in the known distance and in 
unit of length add nm then ok  

Thoria Donia 



Choose Rectangular selection and select 
the area you want to analyze then image 
crop 
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Image then 8 bit then image and adjust
threshold and change the upper scroll
then apply
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You will get such view 
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Analyze -----analyze particles and in show 
choose masks and you can save the new image 
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File -----save as 
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Select specific partition and analyze your 
results using excel 
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Edit ----distribution to see distribution of particle size 
in the image and you will get distribution window keep 
all information in default version  then click ok  
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You will get area distribution graph as following by
clicking on list you will get the next window
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Distribution histogram 

• Size range ….split into small size classes
or bins and the no. of particles
contained in each size bin are counted.
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You can save data for area distribution for
further analysis
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Quantifying Stained Liver Tissue
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Open the image in image J 

• File ….open …..choose its location…..open
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shift with straight line selection on 
200um scale at the end of image 
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Enter the scale bar length (200 µm) as the
"Known Distance" and "um" as the "Unit
of Length".
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Dimensions changed to um scale  
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Image ----type ---RGB stack to split the 
image into red, green and blue channels.
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You will get such view 
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Move the slider to view each of the channels.
Notice that the green channel has the best
separation.
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Image>Stacks>Make Montage to view all three 
channels at the same time.
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Click ok in make montage box 
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All three channels will appear at the same time 
appear 
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Select the RGB stack (with the Green channel 
selected) and press shift-t 
(Image>Adjust>Threshold). 
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Set threshold level in the upper threshold 
level 
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Click apply 
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Analyze>Set Measurements dialog and checking 
"Area", "Area Fraction", "Limit to Threshold" 
and "Display Label"
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(Analyse>Measure)
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The area and percent area will be
displayed in the "Results" window
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Save results by clicking Save As"
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Counting cells in this image
first open this image in image J  

Thoria Donia 



To remove noise click process….subtract 
background 
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Add any number according to intensity of noise 
for example 12  and then ok 
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You will get such view 
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Image …adjust threshold and adjust only 
black and white 
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If nothing happen just make your image 8
bit and then change the upper scroll till
you get clear cells
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Click apply 
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To fill holes in cells choose process then 
binary then fill holes 
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For much processing process…binary 
….convert  to mask 
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To separate the connected cells
process ----binary ….watershed
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You will get a line between connected 
cells 
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Analyze…..….analyze particles
add size to be 120-infinity and show outlines and keep
other settings in default format
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You will get summary and detailed results 
and all noise was deleted 
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